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1. Intro

Griffin is a powerful automatic layout solution for wide format printers. Its primary goals are to
increase efficiency and reduce errors by automating repetitive tasks and bring down material
waste through the use of a sophisticated nesting algorithm.

1.1. Installing Griffin

To get started with Griffin, you will first need to download and run the installer.

Proceed as follows:
1. Check the system requirements on enfocus.com.

2. Double-click the installer provided to you by your local reseller.
The Windows installer is an MSI file, the Mac installer is a DMG file.

3. Do one of the following:

- On Windows, follow the steps in the installation wizard. During installation, you are given
the option to create a desktop shortcut for Griffin.

« On Mac, once installed, drag the Griffin app to your Applications folder.

1.2. Activating Griffin

After successfully installing Griffin, you are ready to activate your license.

Griffin supports both traditional activation keys as well as cloud licenses. Tilia Cloud licenses
allow you to float and centrally manage your licenses across your teams. Note that you need an
internet connection in order to activate your license. For more information, refer to Licensing on
page 56.

Proceed as follows:

1. Launch Griffin.

When launching the application for the first time you are presented with a licensing dialog for
logging in with your tilia Cloud ID.


https://www.enfocus.com/en/support/system-requirements/griffin-system-requirements
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Sign In
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2. Do one of the following:

- If you have purchased a tilia Cloud license, enter your User ID (which is your email
address) and password and click Sign in.

Griffin

« If you have purchased a key or license file, click Activate with license key or file and, in

the dialog that appears, do one of the following:

Your license is activated. You can now start using the software.

Copy and paste the license key provided to you by your local reseller and click
Activate.

Click Import License and import the license file.

Activate License Key

Bleate ente youl BEUVoN kiy. 0 you e porchirsed 8 BCenss of degosated &
rial o will K T 3 Setivition kiy by emad.

3. Click Done.
The Start window is displayed.

Read more about the main Griffin windows or learn how to create and configure a job.
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1.3. Closing Griffin

To close the application

Do one of the following:

.« On Windows, click File > Exit.
« On Mac, click Enfocus Griffin > Quit Enfocus Griffin.

You will be prompted if any Job windows contain unsaved jobs.

Closing all the Job windows in Griffin will pull up the Start window again. If you close the Start
window:

« On Windows, the application will close down.

« On Mac, the application will remain open. Griffin is still accessible at that point from the
standard Mac menu bar.
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2. The Griffin user interface

2.1. Language of the Ul

The interface of Griffin is available in the following languages:

English

Japanese

Italian

French

German

Spanish
The language defaults to the language of the operating system. It's not possible to manually
switch to another language.

2.2. Start window

When you first start Enfocus Griffin you are presented with the following start window:

] Enfocus Griffin

Untitled-1.gfn New...

MyFirstJob.gfn ]

Open...
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This window gives you a list of recent jobs and buttons for creating a new job or opening an
existing job from the file system. The start window will close once a new or existing job is opened
and reappear when all job windows are closed.

2.3. Job windows

Job windows are where all your work building layouts is done. New and existing jobs are opened
in their own job window. Griffin allows multiple job windows to be open so you can work on
different jobs at the same time.

The diagram below shows the sections that make up a job window:
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Main view (A)

The green section labeled 'A' is the main view. The main view takes up most of the job window
and displays the list of artwork or layout items in the job depending on what view you are in. You
can also drill into a specific artwork or layout item to interact directly with items, change zoom,
and more.

Sidebar (B)

The orange section labeled 'B' on the right-hand side of the job window is the sidebar. The
sidebar is where you can view and edit properties for the currently selected item(s) in the main
view.
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Toolbar (C)

The purple section labeled 'C' above the main view is the toolbar. The toolbar lets you switch
between Artwork list and Layout list. It also lets you edit the job properties, launch the Nesting
tool, add marks, and add or remove artwork and layout items. More actions are available when
you drill into a specific artwork or layout item such as tool path edit tools and zoom controls.

Button Description
| Add Artwork Edit job properties.
> Job Properties Edit job properties.
L=
] Artwork/Layout List Toggle between Artwork list and Layout
o— _.'_ list.
oo Nesting Launch the Nesting tool to generate
doo layouts.
Sl Marks Add new marks to the selected artwork(s)
ABCT or layout(s).
. Remove Artwork/Layout Remove all selected artwork or layout
I items from the job.

2.4. View modes

One of the most important concepts in Griffin is the current view mode.

In the job window, you are always working with either artwork or layout items, and for each there
are two modes: List mode and View mode.

When the job window first appears, it will be in Artwork list, where you manage the artwork items
in your job. Layout list, on the other hand, lets you manage the layout items in your job.

Artwork view and Layout view are detailed views of a specific artwork or layout item respectively.

To switch between Artwork list and Layout list, click the respective icons in the toolbar:

Artwork list selected
= [

Layout list selected
= |IJ
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2.4.1. Artwork list and Artwork view modes

Artwork list mode

Artwork list is where you can see a list of your current artwork as well as add, remove, edit, and
drill into individual artwork items.
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When you first open a new job window you will be in Artwork list mode which displays a list
of artwork items in the current job. For an overview of the tools, refer to the description of the
toolbar in Job windows on page 8.

Artwork view mode

If you want to view or edit an artwork item in more detail, double-click the artwork item in the list
to enter the Artwork view for the given artwork item.

The main view will now contain an interactive view of the artwork item.

10
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The toolbar will change to the following set of actions:
Button Description

Return to List

Go back to the list of all
artwork items in the job.

Select Tool

Select artwork marks in the
main view.

Zoom Tool

Click + drag to zoom into a
specific area of the artwork in
the main view.

| O]

Hand Tool

Click + drag to move around
the main view and scroll in/out
to zoom.

B
0=
4

Marks

Select a mark type from the
dropdown menu to add a mark
to the artwork.

Edit Tool Paths

Edit the tool paths of the
artwork directly. See Tool path
editing on page 47.

85%

Zoom %

Select from the drop down to
change zoom amount in the
main view.

1"
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Button Description
View Front/Back Toggle between viewing the
Front Back front and back of the artwork.

2.4.2. Layout list and Layout view modes

Layout list mode
Layout list and Layout view operate in the same way as their artwork counterparts. When you

click on the Layout list button in the toolbar you are presented with a list of all current layout
items in the job.

ﬂ Note: Before running the Nesting tool this list will be empty. Once you have generated
layouts, you will see them in this view.
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Layout view mode

Once you have generated layouts, you can select them to edit properties in the sidebar or
double-click on one to enter Layout view for that specific layout item.

In Layout view, the toolbar will change as it does in Artwork view. You are given the same set of
actions minus the Edit Tool Path action. See Artwork list and Artwork view modes on page 10.

Using the select tool, you can move artwork and marks directly in Layout view around by clicking
and dragging.

ﬂ Note: The shift key works as a modifier while moving artwork in the Layout view to lock
movement only in a horizontal or vertical direction.

12
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2.5. Nesting tool

The other major component of Griffin is the Nesting tool. This tool automatically creates efficient,
nested layouts from the artwork in your job for either roll- or sheet-fed environments.

oo0
To launch the Nesting tool, click the Nesting icon “* in the toolbar while you are in artwork list or
layout list mode.

Once the Nesting tool is opened, you can select the substrate you want to nest artwork onto,
change nesting settings if needed, and add mark presets that will be applied to the generated
layouts. Next simply click Start and let Griffin go to work.

For more information, refer to Creating layouts on page 18.

13
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Note: While you can have multiple job windows open at a given time, Griffin only allows
you to run one Nesting tool session at a time.

2.6. Menus

Menus are the other way of interacting with Griffin. On Windows, the menu bar appears at the

top of each window of the application, while on Mac the standard Mac menu bar at the top of the
desktop is utilized.

#

@ Enfocus Griffin File Edit View Window Help

The following menus are available:

Menu Description

Enfocus Griffin (on Mac) Check the About panel, set the preferences or close
the application.

File Create, open, and close jobs. Import artwork. Export
printing and cutting files.

Edit Undo/redo, cut/copy/paste, remove, select/deselect,
and - only on Windows - launch Preferences.

View Fit in view, zoom, show rulers, show bleed paths.

Window Manage Substrates, Tool Types, Mark Presets, and

Tiling Presets. Minimize. Switch windows.

Help Check the info about your license, deactivate your

license as required, or consult the user guide and -
only on Windows - the About panel.

14
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3. Setting up a Griffin job

3.1. Creating a Griffin job

To create a new Griffin job, proceed as follows:

1. Launch Griffin.
The Start window appears.

2. Do one of the following:

« Inthe upper right part of the start window, click New.
« Click File > New.

A new job window appears. The Artwork list in this window is empty.

Proceed with the configuration of your job: set the job properties, add artwork, and create the
layouts as described further.

3.2. Setting the job properties

Info about the current job (such as the job name and the client contact details) can be recorded in
the Job properties window. Note that this information can be used in dynamic text and barcode
marks.

Note: Setting the job properties is optional. If no filename is defined, the job will be
named Untitled-<number>.

To set the job properties
1. In the toolbar of the job window, click the Job properties button Z.
The job properties window appears.

15
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Filename Job_1

Job ID

Job Name

Contact Name

Contact Phone

Client Name

MNotes

=1 KN

2. Enter the job info.

3. Click OK.
The window is closed and you're back in the job window. The entered filename is displayed
in the header of the job window.

3.3. Adding artwork

Enfocus Griffin supports PDF and PDF-based lllustrator (Al) formats, as well as TIFF, BMP, PNG,
JPG, and GIF image artwork formats.

To add artwork to your job

1. Do one of the following:

In the toolbar of the job window, click the Add Artwork button
« From the menu, select File > Import Artwork and select your artwork.

and select your artwork.

« Drag your artwork directly into your job window from Finder (macOs) or Explorer
(Windows).

Note: Griffin supports up to 100 artwork files in a job.

The added artwork is shown in the main view, in Artwork list mode.

2. Check and configure the artwork properties as required, for example the quantity, the
dimensions, the needed bleed, spacing, flutes, etc.

a. Select the artwork of which you want to edit the properties.
b. Switch to the artwork tab on the right of the window (as required).
c. Edit the artwork properties.

16
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Note that the property values are applied immediately, when changes are made. For
example, when you change the quantity, it's also updated in the right part of the job

window.

Note: If you select multiple artwork items in the Artwork list, changing the property
values in the sidebar will update all selected items simultaneously!

3.3.1. Artwork properties

Property Description

Front The artwork file and page number to use for the front side content of
this artwork item.

Back The artwork file and page number to use for the front side content of
this artwork item.

F | B button Mirror Front to Back: When clicked, a mirrored copy of the front side
artwork content will be used on the back side of the artwork item.

F | F button Front to Back: When clicked, the front side artwork content will be used

on the back side of the artwork item as well.

Create Tiles button

Create tiles from the selected artwork. When clicked, the tiling view will
appear allowing you to change tiling settings with a live preview of the
tiles. See Tiling on page 48 and Managing tiling presets on page

40.

Image Tracing button

Generate tool paths around image contours automatically. When
clicked, the image tracing view will appear allowing you to fine-tune
settings and preview the generated shape path. See Image tracing on
page 52.

Open in Editor button

Open the file in the editor that is by default associated with the
selected file type. You can make changes and save them in the editor;
when going back to Griffin, you'll be asked if you want to reload it.

Tip: You can open your PDFs in Adobe Acrobat and use
Enfocus PitStop Pro to generate a bleed and cut path. More
info about PitStop Pro on the Enfocus website.

Note that you can open several files in one go; each will open
separately in the associated editor.

Quantity

Number of artwork items needed in this job, used by the Nesting tool
to ensure your orders are all placed onto layouts.

Placed

(Read only) The current total number of placed copies of this artwork
item across all layouts in this job.

Width / Height

The dimensions of the artwork item. Both width and height can be
edited which will cause the artwork item to be scaled automatically.
When the percentage sign is selected (%) the dimensions are
determined based on the percentage of original artwork content on the
front side of the artwork item.

Bleed

The type of bleed mask to apply to the artwork item:

17
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Property Description

. Offset: In this case, you can change the bleed mask distance from
the shape of the artwork item in the field to the right of the bleed

type.
+ None
Spacing The type of spacing the Nesting tool will use to determine how close to

place artwork items together when generating layouts:

« Tool: Tool spacing will use the Cutting Width of the tool type of the
cut paths in the artwork item to determine the necessary spacing.

- Bleed: Bleed spacing uses the bleed masks in the artwork item for
spacing, ensuring bleed masks do not overlap.

. Offset: When Offset is used, you can change the spacing distance
from the shape of the artwork item in the field to the right of the
spacing type.

Flutes The required flute (= grain) direction for this artwork item:

« Horizontal

« Vertical
« None

Shape Source (Read only) A description of where the shape of the artwork item came
from.

Tool Types A list of all the tool types in selected artwork item(s). Click the edit icon

below the list to change tool type mappings for all selected artwork
items. See Managing tool types on page 28.

3.4. Creating layouts

Layouts are created using the Nesting tool.

Proceed as follows:
1 1n the toolbar of the job window, click the Nesting tool button =5 .
The Nesting tool is opened.

2. Select the substrate and the board/roll you wish to use.

3. Edit the layout properties as required.

These settings are used by the Nesting tool to create the layout. For a detailed overview,
refer to layout properties.

4. Select the Close when done checkbox.

If not selected, you have to close the window yourself after the layouts are generated, by
clicking the X button in the top right corner of the job window.

5. Click Start.

18
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The generated layouts are shown in the Layout list.
Once you have created a layout, you may want to make manual adjustments:

« Make layout adjustments

- Add barcodes and/or camera marks to your layouts

3.4.1. Layout properties (Nesting tool properties)

Note: You can manually change the below options for a particular job. Alternatively, you
can configure default values for these options in the substrate. See Managing substrates
on page 27 on how to define substrates.

Property Description

Substrate The substrate to use.

Board / Roll The board or roll size from the substrate to use.

Margins The amount of empty space needed from the edges of the

board or roll. The Nesting tool will not place any artwork item
cut paths within these margins.

Note: Artwork bleed can go outside the margins - the
margins only account for area where cut paths will not
be placed.

Strategy The type of layout to generate based on your cutting
requirements.

« Free Nesting: Enables the Nesting tool to nest artwork
items in any way to produce the tightest packed layouts.

« Grid Nesting: Ensures artwork items are placed in nested,
repeating grid patterns.

- Guillotine: Produces layouts that can be cut out by a
guillotine cutting device.

First Cut For Guillotine layouts, set whether the first cut needs to be
horizontal, vertical, or either.

Rotation Allowed rotation of artwork items being placed: Orthogonal,
Any, or None.

Placement The placement of artwork items relative to the board or roll.
Roll Cut-off Minimum and maximum lengths allowed for rolls.
Double Sided Whether double sided handling is turn or tumble based. When

the Nesting tool places double-sided artwork items on a layout
it will automatically mirror the layout on the back side based on
this setting to ensure alignment between front and back.

Allow multiple layout copies Whether to allow multiple layout copies. When artwork item
quantities are two or more times higher than the amounts
placed on a layout, the Nesting tool will increase the number
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Property Description

of copies of the given layout instead of generating new layouts
to fulfill those artwork items.

Separate single and double When enabled, single- and double-sided artwork items in the
sided job are always placed into separate layouts.
Mark Presets A list of pre-defined marks to automatically add to generated

layouts. See Managing mark presets on page 30.

3.4.2. Making layout adjustments

The Nesting tool is designed to produce efficient, print-ready layouts, but you can also go into
individual layouts at any point and adjust artwork and mark item positions manually.

1. Inthe Layout list, double-click on the first layout to enter the Layout view.
In Layout view, you can move the artwork items as required and add, edit, or remove marks
from the layout as required.

2. To move an artwork item, select it and move it with the mouse or the arrow keys.

Note: You can also select and move several artwork items in one go!

3. To change layout properties, change the properties on the Layout tab and click Fit layout.
See also Layout properties (Nesting tool properties) on page 19.
4. To add, edit or remove marks, click the Marks tab and do one of the following:

« To add a pre-defined mark preset, click the plus sign and select one of the available mark
presets.

Note: If the list of mark presets, is empty, you still need to add mark presets to the
mark presets library.

To add a new mark, click the Marks icon **" in the toolbar (in either list or view mode)
and choose the appropriate mark type. Change the properties of the chosen mark type as
required.

« To edit a mark, select the mark concerned and change the properties as required.
« Toremove a mark, select the mark concerned and click the recycle bin icon.

For a detailed overview of all mark properties, refer to Managing mark presets on page 30.

The changes are immediately applied in the Layout view.

3.4.3. Adding marks and barcodes to your layouts

Marks can be added to artwork or layout, in both list or view mode.

Proceed as follows
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Select the artwork or layout concerned.

Do one of the following:

In the toolbar, click the Marks icon * > and select the type of your choice. The chosen
mark is added, you can see it in the sidebar, in the list at the top of the Marks tab.

« In the sidebar, switch to the Marks tab and click the + button. You can now select a mark
preset. Note that you can only add mark presets, so not all marks are available in this list!
See Managing mark presets on page 30.

Click the mark you have added by clicking the Marks icon in the toolbar.
The mark's properties are displayed.

Edit the properties as required.

For an overview of all properties, refer to Managing mark presets on page 30.

3.5. Exporting the layout

Once the layout is complete and all marks have been added, the job layouts can be exported.

3.5.1. Exporting files for printing

Once the layout is complete and all marks have been added, the job layouts can be exported for
printing.

To export an imposed printing PDF

1.

From the menu, select File > Export for Printing.
This opens the Export dialog.

Choose a preset or select the type of export you need.

For an overview of the properties, refer to Export for printing properties on page 22

To save the new settings to a new template that you can use later on:
a. Click Save Preset.
b. Choose a name for you new preset.

c. Click OK.
The new preset will appear in the list of Presets.

To export the PDF, click OK.

Enter a name and select a folder to save the PDF.
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6. Click Save.

3.5.1.1. Export for printing properties

Properties Description

Preset Options are:

- An available preset (the Default Printing Preset or an earlier defined
preset). The other properties in this dialog are filled in automatically
based on the chosen preset.

« Custom. In that case, you have to configure the other properties
explained below and click OK to print the PDF.

Note: If you want to re-use the chosen settings, you can
save them as a new custom preset. Click Save Preset and
choose a name for your new preset. It will appear in the list
of presets.

Export as Options are:

- Single File: All sides of every layout are contained in a single multi-
page PDF.

« One File per Layout: One PDF file is created for each layout. If the
layout is double sided, the PDF for that layout will be two pages with
the first and second pages containing the front and back sides of the
layout respectively.

« One File per Side: One PDF file is created for each layout side.

Create page for each | When enabled, this option creates a separate PDF file or page for each
layout copy copy of the layout that is needed to fulfill quantities.

Example: If a layout contains 10 instances of an artwork item that has a
quantity of 100, the number of copies of that layout is 10. If Create page
for each layout copy is NOT enabled, the layout sides are exported
once. However, if enabled, each side of the layout will be exported 10
times, one time for each of the 10 layout copies.

RIP Workflow The RIP Workflow to be used:
. Generic: Generic workflow, for all users
«  ONYX: Workflow specifically for users switching from ONYX TruFit to

Griffin. This workflow provides all functionality ONYX TruFit users are
used to.

Note: If you save a preset with the ONYX RIP Workflow, you
can also use it in the Printing section of the Export Multiple
dialog.

Remove dielines (only | When enabled, original dieline paths are removed from the artwork
when RIP Workflow is | content during export.
set to Generic)
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Properties Description

Note: Currently Griffin can only remove dielines defined using
spot colors in the PDF or Al file, not PDF layer-based dielines.

Griffin

Use PDF 1.6 'UserUnit' | Use this option if you are working with layouts with dimensions over
when layout bigger 200 inches (roughly 5 meters) and your RIP supports the PDF 1.6
than 200 inches 'UserUnit' field to address size limitations in the PDF specification.

3.5.2. Exporting files for cutting

3.5.2.1.

To export the imposed PDF for cutting

1.

From the menu, select File > Export for Cutting.
This opens the Export dialog.

Choose a preset or select the format you need.
Griffin supports 3 formats:

. PDF

. DXF
« Zund Cut Center (ZCC)

The other properties depend on the chosen format.

To generate the right cutting data for your devices, configure the common and format-specific

settings.

For an overview of the properties, refer to Export for cutting properties on page 23.

To save the new settings to a new template that you can use later on:
a. Click Save Preset.
b. Choose a name for you new preset.

c. Click OK.
The new preset will appear in the list of presets.

To export the cutting file(s), click OK.
Enter a name and select a folder to save the cutting file(s).

Click Save.

Export for cutting properties

Properties Description

PDF

PDF cutting files are compatible with several industry standard cutting tables.

Export as There are two options:

- Single File: All layouts are contained in a single multi-
page PDF.
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Properties Description

« One File per Layout: One PDF file is created for each
layout.

Use PDF 1.6 'UserUnit' when layout | Use this option if you are working with layouts with
bigger than 200 inches dimensions over 200 inches (roughly 5 meters) and your
cutting device supports the PDF 1.6 'UserUnit' field to
address size limitations in the PDF specification.

Include Marks Indicate which marks if any to include in cutting output.
Options are:
- Barcode
. Camera
- Fill
+ Text
- Border
+ Cornet

« Grommet

Tool Type Mappings Table of mappings from tool types to colors and PDF layers
expected by your cutting device. Click the icons below the
table to add, edit, or delete mappings.

DXF

DXF (Drawing Exchange Format) is an open standard
CAD format used by several hardware manufacturers.

Version DXF version to use. Options are:
- R13
. 2007

Units Indicate which units to use in DXF path and dimensions
data.

Encoding (R13 only) For the older R13 DXF version you need to specify the

character encoding to use during export. DXF version 2007
and above always uses UTF-8 encoding which supports all
Unicode characters.

Include Marks Indicates which marks if any to include in cutting output.
Options are:

« Barcode

« Camera

« Fill
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Properties Description
- Border
. Cornet

« Grommet

Text marks are not supported in DXF.

Tool Type Mappings Table of mappings from tool types to DXF layer names and

DXF colors expected by your cutting device. Click the icons
below the table to add, edit, or delete mappings.

Zund Cut Center (ZCC)

ZCC cutting export format for tight integration with Zund
Cut Center for customers using Zund cutting tables.

Griffin records various useful information into the ZCC cutting file that is not included in generic
cutting PDFs:

This metadata can be leveraged in Zund Cut Center to choose the correct blades and speeds
for the given cutting table and to report useful information to the operator.

Name of the substrate

Number of required copies of the layout

Flutes direction

The job name which can be defined using dynamic keywords

Job Name The Job Name field in Zund Cut Center. You can use

dynamic keywords to record properties from the current
job or layout along with date and time.

Refer to Keywords overview on page 54

Cutting Mode The cutting mode to use in Zund Cut Center:
- Standard
+ Quality
+ Speed
Tool Type Mappings Table of mappings from tool types to Zund methods.

Mappings are read-only to ensure correct tool mappings
are used.

3.5.3. Exporting files for multiple use (printing + cutting)

You can export both printing and cutting files in a single shot by using the Export Multiple feature.

1.

From the menu, select File > Export Multiple.
The Export Multiple dialog opens. This dialog is divided into Printing and Cutting sections,
which can be set up independently.

Select or clear the Printing and Cutting section checkbox as required.
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3. Configure the settings in each section as required.

For an overview of the properties, refer to Export Multiple properties on page 26

4. To save the new settings to a new template that you can use later on:
a. Click Save Preset.
b. Choose a name for you new preset.
c. Click OK.
The new preset will appear in the list of presets.

5. To export the file(s), click OK.

3.5.3.1. Export Multiple properties

Properties Description

Preset The pre-defined printing or cutting preset you want to use
during export.

Folder Output folder to save exported files to. This can be a hot
folder for your RIP or cutting table software for example.

Filename The filename of the exported files. You can use dynamic
keywords to automatically generate filenames containing
job properties, layout name or ID, current date/time and
more. See Keywords overview on page 54
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4. Managing presets

You can boost your productivity by custom tailoring the Enfocus Griffin application to match your
production environment. This is done by setting up your substrates, tool types, mark presets, and
tiling presets.

4.1. Managing substrates

Substrates represent the different kinds of media that you work with, the board or roll sizes that
are available, and printing margins. In addition, you can define default nesting settings and mark
presets for printing and cutting marks that you always use with the given substrate.

To manage substrates

1. From the menu, select Window > Substrates.
This opens the Substrates dialog, which contains a list of all pre-defined substrates and their
settings.

2. To add a substrate, proceed as follows:

a. Click the plus sign below the list of substrates.
A menu with two available substrate types appears.

b. Select the appropriate substrate type:

« Board-based Substrate
« Roll-based Substrate
c. Configure the properties.
For an overview, see Substrate properties on page 27.

3. To edit a substrate that is available in the library, select it and change the properties as
required.

For an overview, see Substrate properties on page 27.

4. To remove a substrate from the library, select it and click the trash can icon below the list of
substrates.

4.1.1. Substrate properties

Properties Description

Name The name you want to give the substrate.

Vendor Optional vendor name of the substrate.

Color Click the square color icon to change the display color

used for the icon for this substrate. Color does not affect
export in any way or appearance of the substrate in Layout
view.
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Properties Description

Thickness Substrate thickness. Thickness is included in Zund Cut
Center (ZCC) cutting output to automatically match the
substrate with the corresponding material in Zund Cut
Center.

Board Sizes / Roll Widths A list of available board sizes or roll widths. To add a new
board or roll, click the plus icon below the Board Sizes or
Roll Widths list. Use the settings to the right of the list to
configure the new or existing board/roll.

Width Width of the board or roll.
Height Height of the board.
Flutes Flutes (i.e. grain) direction for the board if any. Flutes are

defined by which dimension is longer or shorter.

Margins The amount of spacing from the edges of the board or roll
required. The Nesting tool will not place any artwork item
cut paths within this margin.

Settings Nesting related default settings for this substrate. See
Layout properties (Nesting tool properties) on page 19.

Mark Presets A list of pre-defined marks that will be automatically added
to layouts in the Nesting tool. For example, you might
always want to use a specific set of camera marks or a
barcode for the given substrate. See Managing mark
presets on page 30.

4.2. Managing tool types

Tool types represent the various tools used by your cutting devices to cut, score, crease, etc.
Each tool type defines tool properties as well as a list of mappings from artwork spot colors or
PDF layer names to automatically map paths in your artwork to the correct tool type.

To manage tool types

1. From the menu, select Window > Tool Types.
This opens the Tool Types dialog, which contains a list of all current tool types and their
settings.

2. To add atool type, proceed as follows:
a. Click the plus sign below the list of tool types.
b. Configure the properties of the new tool type in the right part of the screen.

For an overview, see Tool type properties on page 29.

3. To edit a tool type that is available in the library, select it and change the properties as
required.

For an overview, see Tool type properties on page 29.

4. To remove a tool type from the library, select it and click the trash can icon below the list of
tool types.
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Note: You can order the tool types in the list via drag and drop. The mappings are
searched in order of the tool type from top to bottom of the list.

4.2.1. Tool type properties

Tool types

Properties Description

Name The name you want to give for the tool.

Subtitle Optional additional information you want to add for this
tool.

Color Click the square color icon to change the color used to
draw tool paths of this type in Artwork view and Layout
view as well as the icon for this tool type. Color does not
affect export in any way.

Category The tool category this type belongs to:

« General
« Cut
+ Crease

« Annotation

Cut tool types are used to determine the shape of the
artwork item and additional properties that can affect
nesting.

Cutting Width (Cut category only) | The width of the cutting tool. This property can be used to
define the spacing distance between items the Nesting tool
uses if the artwork item's spacing type is set to 'Tool'.

Use as default cutting tool (Cut Set this cutting tool as the default tool for cutting. When
category only) no paths in the artwork match any cut tool types, the
rectangular dimensions of the artwork are used as the
shape (Trimbox for PDF and Al formats) with the default
cutting tool used as the tool type for the shape.

Mappings A mapping automatically maps paths in the artwork content
to the correct tool type when new artwork is added to your
jobs.

To add a new mapping, click on the plus icon below the
Mappings list. You will be presented with a mapping dialog.
The settings in this dialog are explained in the table below.

Mappings - properties

If you add a new mapping (to automatically map paths in the artwork content to the correct tool
type when new artwork is added), you must configure the following properties:
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Properties Description

Source The source of the mapping for PDF-based artwork formats.
Options are:
. Spot
« Layer

Text The type of mapping rule you want to use:

« Equals + text to match: This will match the given text
exactly with spot or layer names in the artwork content.

« Starts with + text to match: This will match the given text
with the beginning of the spot/layer name.

« Contains + text to match: This will match the text with
any portion of the spot/layer name.

Note: All text matching is case insensitive.

Offset (Cut category only) An optional offset to apply to the shape. Negative offset
values will cause the shape to be reduced while positive
values will increase the shape path. For example, this
setting is useful to prevent a wider cutting tool from cutting
into artwork content.

Join Style (Cut category only) The style used to join path segments in the shape when an
offset is applied. Options are:

« Miter
+ Bevel
+ Round
Miter Limit (Cut category only) In cases where an offset is defined and the join style is

'Miter' the miter limit defines the distance beyond the end
of the joined path segments where mitering is clipped to
avoid long spikes on sharp corners.

Note: Once you have defined some mappings you can move them around in the list by
dragging and dropping them with the mouse. The order of mappings can be important
because once a stop color or layer name matches a tool type mapping, the other
mappings below the matching one are not checked against that name. To ensure correct
matching it is best to move mappings with more unique names higher in the mapping
tables, with general catch-all names like 'cut' further down in the list.

4.3. Managing mark presets

Mark presets can help streamline your workflow by defining commonly needed marks once and
reusing them. When paired with substrates, marks are added automatically when layouts are
created with the Nesting tool, further reducing time and possible errors.

To manage mark presets

1. From the menu, select Window > Mark Presets.
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This opens the Mark Presets dialog, which contains a list of all current mark presets and their
settings. Mark presets are separated into two categories: Artwork and Layout. The currently
active category is mentioned below 'Mark Presets'.

2. To change between artwork and layout mark preset lists, click the dropdown to select
Artwork or Layout as required.

3. To add a mark preset, proceed as follows:

a. Click the plus sign below the list of mark presets.
You will be presented with a menu with all supported mark types depending on whether
you are adding artwork or layout mark presets.

Select the appropriate mark preset type.
Configure the properties of the new mark preset in the right part of the screen.

For an overview, see:

«  Common mark properties on page 31

« Barcode properties on page 32

« Border mark properties (only in Layout view) on page 33
« Camera mark properties on page 34

« Corner mark properties on page 36

« Fill mark properties on page 37

« Grommet mark properties on page 38

« Text mark properties on page 39

4. To edit a mark preset that is available in the library, select it and change the properties as
required.

For an overview, see higher (3rd substep of step 3).

5. Toremove a mark preset from the library, select it and click the trash can icon below the list
of mark presets.

4.3.1. Common mark properties

The following are a list of properties shared among two or more different mark types.

Properties Description
Name The mark preset name.
Subtitle Optional additional information you want to add for this

mark preset.

Color Click the square color icon to change the display color
used for the icon for this mark preset. Color does not affect
export in any way or appearance of the mark in Artwork
view or Layout view.
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Properties Description

Smart Placement (Barcode, Text) | The placement rule to use when positioning the barcode
or text mark into the artwork or layout. Use the 9-point
selector to change which point on the mark (small square)
is aligned to which point of the artwork or layout (large
square). Use the 'X' and 'Y' values to define offsets from
these anchor points with positive values moving the mark
left and up respectively. You can also change the rotation
of the mark by selecting the 'R' dropdown.

Layer Optional PDF layer name. When specified the marks will be
placed in a PDF layer of the same name during printing and
cutting export.

Stroke (Border, Camera, Corner, The stroke color and thickness of the camera or grommet
Grommet) mark. To change color, click on the square color icon.

Fill (Border, Camera, Barcode, The fill color of the mark content for camera and fill mark
Text, Fill) types and barcode and text color for barcode and text

marks. To change color, click the square color icon.

4.3.2. Barcode properties

Barcodes are available in four standard formats: Code 39, Code 128, POSTNET and QR Code.
Barcodes can be applied to both artwork and layouts. All four formats have support for dynamic
keywords for encoding job, layout, date, and artwork properties into barcodes automatically.

32



ENF@CUS

12345
1

2345abc

Below is a list of properties to control the size and content of barcodes, in addition to the
common properties described in Common mark properties on page 31.

Properties Description
Format Options are:
+ Code 39
« Code 128
« POSTNET
+ QR Code
Data Click in the text area to enter the content you want the

barcode to contain. To add a dynamic keyword, click the
Keyword button and select the desired keyword from the
menu that appears. For an overview of the keywords, refer
to Keywords overview on page 54.

Show Human-Readable (Code 39, |If enabled, plain text of the data content will be included
Code 128) below the barcode.

Scale Scale factor to apply to the barcode to increase or
decrease its size.

4.3.3. Border mark properties (only in Layout view)

Border marks are rectangular paths drawn at a given margin from the edge of the layout. Border
marks are used for certain cutting devices such as Mimaki cutters.
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Border mark paths can be both stroked and filled. Stroke color and thickness and fill color are
defined via the common Stroke and Fill properties (see Common mark properties on page 31).

Additionally, the following margin settings control the dimensions and placement of the border

mark.

Properties Description

Top Distance from the top edge of the sheet in the downward direction to
draw the top edge of the border mark.

Bottom Distance from the bottom edge of the sheet in the upward direction to
draw the bottom edge of the border mark.

Left Distance from the left edge of the sheet in the right direction to draw
the left edge of the border mark.

Right Distance from the right edge of the sheet in the left direction to draw
the right edge of the border mark.

4.3.4. Camera mark properties

Camera marks are needed by camera-based cutting table registration systems. Griffin camera
marks are flexible and should support all major cutting table vendors.
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Camera marks support both circular and cross shapes. Circular shapes can be both stroked and
filled. There is also an intelligent auto distribute feature with various options to automatically
place camera marks near artwork items throughout the layout.

Below is a list of camera mark properties in addition to the common properties described in
Common mark properties on page 31.

Properties Description
Shape Type Three options:
. Circle
« Square
« Cross
Size The size of each camera mark instance.
Offset The offset to place camera marks from the shape of

artwork items.

Auto Distribute Whether to automatically place camera marks throughout
the layout. When disabled, only corner camera marks are
placed.

Mode Distribute mode to use when auto distributing:

« Spacing: Marks will be distributed throughout the layout
at certain spacing interval.
« Quantity: A specific number of marks will be played in

the layout.
Min Spacing (when Mode = The minimum distance allowed between camera marks
Spacing) when using Spacing auto distribute mode. Increasing this
number will reduce the number of camera marks placed in
the layout.

Quantity (when Mode = Quantity) | The specific number of marks to add when using Quantity
auto distribute mode. This is useful in cases where

you know how many extra marks you want Griffin to
automatically add regardless of the layout size.

Note: It is not guaranteed that the quantity target
can be met if the amount of empty space in the
layout is limited.

Add Corners Whether to place camera marks in the four corners of the
layout.
Double Corner Whether to include a second corner mark in the lower-right

corner of the layout. If enabled, the second corner mark
placed to the left of the right corner camera mark by the
specified distance.

Margins Two options:

« Layout Margins ensures camera marks are not placed
outside the allowed content region of the layout.
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Properties Description

« Custom Margins allows to define custom distances
from each sheet edge where camera marks can be
placed.

Mirror to Back When enabled, camera marks are automatically mirrored
to the back side of the layout. This is useful for cases when
the layout will be getting cut face down on the cutting
table.

4.3.5. Corner mark properties

Corner marks are placed at the four corners of the given artwork or layout. Corner marks are
used by certain cutting devices such as Mimaki cutters.

Corner marks come in two flavors: Type 1and Type 2. Both types are simple "L" shaped stroked
marks, with Type 1 corner marks facing towards the artwork or layout and Type 2 facing outwards.

Type 1

Type 2
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Below is a list of corner properties in addition to the common properties described in Common
mark properties on page 31.

Properties Description

Width Width of each corner mark, i.e. the distance from the
corners to extend the horizontal lines.

Height Height of each corner mark, i.e. the distance from the
corners to extend the vertical lines.

Horizontal Distance Optional distance to offset the corner mark in the horizontal
direction. Positive values will move the corner point away
from the artwork or layout while negative values will move
the corner point inside the artwork or layout.

Vertical Distance Optional distance to offset the corner mark in the vertical
direction. Like Horizontal Distance, positive values will
move the corner point away while negative values with
move the corner point inside the artwork or layout.

4.3.6. Fill mark properties

Fill marks are used in artwork to place ink below the shape of the artwork item. To configure a
fill mark, set the common Fill color property as well as the Margin offset value if you want the fill
mark to extend beyond the shape of the artwork item. See also Common mark properties on
page 31.
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4.3.7. Grommet mark properties

Grommet marks are placed evenly across edges of artwork or the layout. Often, they are used to
denote grommet or punch hole locations for hanging pieces. Grommets can be crosshair, circle,

or cross shaped.

Use the Stroke common property to define stroke color and thickness (see Common mark
properties on page 31). In addition, there are a number of properties specific to grommet

marks:

Properties

Description

Shape Type

Choose between

« Crosshair
. Circle
« Cross

Size

The size of each grommet mark instance.
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Properties Description

Circle Diameter (Crosshair Shape) | The diameter of the inner circle in crosshair shaped
grommet marks.

Margin The margin offset to place grommet marks from the bounds
of the artwork or layout.

Hem The width of the hem.

Marks on hem If enabled, grommet marks will be mirrored onto the hem

so they line up when the edges are folded.

Spacing Type This property controls how grommet marks are distributed
across the edges:

« Max Spacing: will evenly place marks placing them as
far apart as possible up to the max spacing distance.

- Quantity: will place exactly number of marks defined in
the horizontal and vertical quantity properties.

Edges Include or exclude specific edges.

4.3.8. Text mark properties

Text marks can be used in both artwork and layouts, and can contain static text, dynamic text
keywords or a combination of both.

Static Text 210.997 mm X 1654717 mm

Text color is controlled by the common Fill property (see Common mark properties on page
31). Text marks also include the following properties that allow you to control text content and

appearance:
Properties Description
Font Select the font you want to use from the font dropdown.
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Properties Description

Font Size Select the font size you want to you from the size
dropdown.

Font Style Choose what font style you want the text mark to appear

as. Options vary depending on the font you are using, but
most fonts support 'Normal', 'Normal Italic', 'Bold', and 'Bold
Italic' styles.

Content Click in the text area to enter the content you want for
the text mark. To add a dynamic keyword, click on the
Keyword button and select the desired keyword from the
menu that appears. See Keywords overview on page 54.

4.4. Managing tiling presets

Tiling presets are pre-defined tiling settings that you can quickly select when using the Griffin
tiling feature. If you are creating tiles using the same or similar settings on multiple occasions,
then defining presets can save you time and reduce errors.

To manage tiling presets

1. From the menu, select Window > Tiling Presets.
This opens the Tiling Presets dialog, which contains a list of all current tiling presets and their
settings.

2. To add a tiling preset, proceed as follows:

a. Click the plus sign below the list of tiling presets.
b. Configure the properties of the new tiling preset in the right part of the screen.

For an overview, see Tiling preset properties on page 40.

3. To edit a tiling preset that is available in the library, select it and change the properties as
required.

For an overview, see Tiling preset properties on page 40.

4. Toremove a tiling preset from the library, select it and click the trash can icon below the list
of tiling presets.

4.4.1. Tiling preset properties

Tiling presets are pre-defined tiling settings that you can quickly select when using the Griffin
tiling feature. If you are creating tiles using the same or similar settings on multiple occasions,
then defining presets can save you time and reduce errors.

Properties Description

Name The tiling preset name.

Subtitle Optional additional information you want to add for this
tiling preset.
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Properties

Description

Color

Click the square color icon to change the display color
used for the icon for this tiling preset. Color does not affect
export in any way or appearance of the tiling in Artwork
view or Layout view.

Start Corner

Tiling preset settings to use.

Tile Order

The order to perform tiling, horizontal or vertical, snake or
zigzag.

Default Cut Tool

Cut tool to use for tiles when artwork is non-rectangular.

Horizontal Tiling | Vertical Tiling

Method defining the tiles in the given direction. Options
are:

- Fixed number: The exact number of tiles is specified,
and Griffin creates equally divided tiles in the specified
dimension

- Fixed size: The size of each tile is specified, and Griffin
will create as many tiles of this size to fit the length of
the artwork, with the last tile filling any remaining space
less than the tile size

- Variable sizes: A comma-separated list of tile sizes
is entered, and Griffin creates tiles of this size either
from left to right (if horizontal tiling) or top to bottom (if
vertical tiling).

« None: No tiling is done in the specified dimension.

See also Tyling types: examples on page 49.

Tiles | Size | Sizes

The number of tiles or size(s) of tiles in the given direction.

Uniform Final Size

When defining a fixed number of tiles, enabling this option
ensures the final tile sizes are uniform regardless of gap
or overlap settings. When not enabled, inner and edge
tile sizes can differ because uniform tile sizes are then
calculated before gap or overlap rules are applied.

Tiling Method

Tiling method to use in the given direction if any. Options
are:

- Gap
« Overlap

Overlap Rule

Rule defining what edge(s) of tiles will overlap with
neighboring tiles.

Overlap Distance beyond tile edge to extend the tile in the given
direction to create overlap.

No-Image Width of the section at the end of the overlap where no
artwork content is allowed, e.g. glue strips.

Gap Gap distance between tiles in the given direction.

Extension Amount of extra artwork content beyond the tile gap edge

to extend in the given direction.
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Properties Description
Direction Rule defining which direction(s) the gap is extended for
each tile.
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5. Managing the application preferences

5.1. Configuring the preferences

To edit the application preferences

1. From the menu, select..
« On Windows: Edit > Preferences.
« On Mac: Enfocus Griffin > Preferences.
2. Select the category of your choice and configure the preferences.
« General
o Artwork
« Presets

- Diagnostics

3. Close the dialog.

5.1.1. General preferences

Preferences

Description

Units

Default units to use when creating new jobs.

Note: You can also change the units used for a
given job by right-clicking the main view ruler in
Artwork view or Layout view.

1 Meters

b C?rjtlmeters J—

 Millimeters
Micrometers

—: Thou
i Points

Display Precision

The number of decimal places to display for floating point
based properties.
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Preferences

Description

For example, in the example below which shows the
dimensions of the artwork, the display precision is set to 2.

Quantity 5 Placed 1
Width 439.88 mm

9
Height 1852.4 mm
Bleed Offset v 3mm
Spacing Bleed v
Flutes None v

Use PDF 1.6 'UserUnit' when layout

bigger than 200 inches

Use this option if you are working with layouts with
dimensions over 200 inches (roughly 5 meters) and your
RIP supports the PDF 1.6 'UserUnit' field to address size
limitations in the PDF specification.

5.1.2. Artwork preferences

Preferences

Description

Default Bleed

When artwork items are created, an offset bleed mask is automatically
generated. Default Bleed controls the default offset of the bleed mask
from the artwork item shape. Bleed offset and type can be changed

at any time by editing artwork item properties. See also Artwork
properties on page 17.

Default Gap Margin

The gap margin is an advanced setting used when determining the
overall shape of the artwork item from cutting tool paths in the artwork
content. It represents the maximum distance allowed between two
disjoint paths for them to be considered connected. The default value
is well suited for most environments but if the correct shape of the
artwork items are sometimes not being detected correctly, increasing
this margin might help.

Note: Setting this value too high can affect performance and
lead to path segments being incorrectly connected during
shape analysis.

Multi-page File
Handling

This setting controls what happens when selecting a multi-page
artwork file when adding new artwork. Options are:

« One item per page

« One item per two pages
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Preferences Description

Note: This is the best option if you work with two page
artwork files containing the front and back sides of the
artwork files.

Shape Handling This setting controls what happens when there is more than one
shape within a single PDF or Al artwork page.

Options are:
« Largest (default value): The largest shape on the page is selected

as artwork shape.

« Multiple: Each shape on the page is imported as a separate
artwork piece.

Note: Designers creating multiple shapes on a single
artwork page is a common scenario, especially for multi-
piece products like free-standing display units, clothing,
racing decals, etc. In these scenarios, importing all shapes
directly from the PDF page can be a big time saver.

Detect external artwork | When enabled, Griffin will watch for changes to artwork files in the job
changes (checkbox) and prompt you when changes are detected to see if you would like
to reload the artwork contents.

5.1.3. Preset preferences

Presets preferences allow you to delete presets (for exporting the layout) you have created. Refer
to the topics under Exporting the layout on page 21.

To remove a preset:
1. Select the type of the preset you would like to remove from the Presets list. Options are:

« Export for Printing Presets

« Export for Cutting Presets

« Export Multiple Presets

Select the preset you would like to remove.
3. Click the trash icon below the list.

N

5.1.4. Diagnostics preferences

Diagnostics are useful for troubleshooting problems occurring in the application and exporting/
importing library configuration between different workstations.

Preferences Description

Diagnostic Mode When enabled, additional logging is performed. Typically
this mode is only used when support personnel are
troubleshooting unexpected behavior.
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Preferences Description

Note: Diagnostic mode can affect performance, so
it is better to leave it Off.

Export Technical Report Export a report of the current state of the application and
log messages to help support personnel troubleshoot
problems.

Import Configuration Import the libraries and settings from this or another

Enfocus Griffin installation. The supported file format is the
Griffin library archive (GFNLIB) that was exported via the
Export Configuration action.

Export Configuration Save the current libraries and settings from this Griffin
instance. This option is useful for backups or for sharing
libraries across different workstations. It can also be useful
for support personel to reproduce problems. The export
format is a Griffin library archive (GFNLIB). This file can then
be used by the Import Configuration action.
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6. Advanced topics

6.1. Tool path editing

Griffin provides powerful editing tools to create or edit tool paths in artwork items.

How to enable the tools
To edit an artwork item's tool paths

1. To open the artwork in Artwork view mode, double-click the artwork item in the Artwork list.
2. r

O

In the toolbar, select the Edit Tool Paths button

Tools

You can directly manipulate the artwork tool paths by using the tools from the toolbar:

o T[] Pt -

Icon Tool Description

s Accept Changes Commit the changes that were made during
this editing session.

h‘ Selection Tool Select tool paths in the main view.
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Icon Tool Description

L\ Direct Selection Tool Select and move individual control points on a
¢ path.

Y Zoom Tool Zoom in and out of the main view.

S,
™ Hand Tool Grab the main view to move around and scroll
O to zoom in and out.

\ Line Tool Draw lines directly into the main view.

I:I Rectangle Tool Draw rectangles directly into the main view.
— Ellipse Tool Draw ellipses directly into the main view.

| |

L

A Pen Tool Draw paths (lines and curves) directly in the
e main view.

A Add Anchor Points Add anchor points to an existing path.

W

Remove Anchor Points | Remove anchor points from an existing path.

I\ Anchor Point Tool Select anchor points and manipulate the
handles to change the curve shape.

‘é‘c Cut Tool Split a path segment.

Transparency tool Move the slider to change the transparency of
e :

the artwork item.

Reject Changes Exit out of Tool Path Edit mode without

>'< applying any changes made in the edit

session. In Tool Path Edit mode you can also
change the tool type for any tool path by
selecting the path(s) and choosing a different
'Tool Type' in the sidebar.

6.2. Tiling

Griffin includes powerful tiling capabilities with several options controlling how artwork is split up
into individual tiled pieces.
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Tiling can be controlled independently in horizontal and vertical directions. Also, in both
directions you can also optionally define gaps or overlaps between tiles with options for
extending gaps and masking off no-image overlap regions.

Griffin tiling also supports internal cut lines. When artwork contains internal cut lines, these cuts
will be preserved in the corresponding tiles, allowing you to handle multi-step panel installations
like non-rectangular peal-offs.

6.2.1. Creating tiles from artwork

To create tiles from artwork
1. Inthe Artwork list, select the artwork item you want to tile.
2. Inthe sidebar, switch to the Artwork properties tab as required.

3. Click the big blue Create Tiles button.
The Tiling view opens where you can see a live preview of how the tiles will be created with
the current settings. Tile dimensions, order, and gap/overlap regions are all displayed in the
preview.

4. Move the Transparency slider as required.

—

The slider controlls the visibility of the artwork content under the tiles being previewed. This
feature is especially useful in cases where the tile preview colors are similar to the artwork
content making it hard to preview the tiles.

5. Edit the settings as required.

See Tiling preset properties on page 40.

Note: The list at the top lists the available tiling presets. See Managing tiling presets
on page 40.

6. Once you have finalized the settings, click Apply.

Each tile will be assigned a number based on the tiling order. You can reference the current tile
number and total number of tiles in artwork text and barcode marks using the <artwork.tile> and
<artwork.tile-count> dynamic keywords. See also Griffin keywords on page 54.

6.2.2. Tyling types: examples

The size of tiles can be defined with the Horizontal Tiling and Vertical Tiling parameter. The
different options are explained below.
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Horizontal Tiling Fixed Number e
Tiles | None
Uniform Final Size Fixed Size
Tiling Method ' Variable Sizes
QOverlap Rule Top v

Fixed number

The exact number of tiles is specified, and Griffin creates equally divided tiles in the specified

dimension.
. .
-- . =2 =
Creates 4 tiles equally divided [
| I 4 e e p—
B D W e
' [——
i - i i
1 b
b.

X
=

Fixed size

The size of each tile is specified, and Griffin will create as many tiles of this size to fit the length of
the artwork, with the last tile filling any remaining space less than the tile size.
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|FREFRI ¢

Variables sizes

A comma-separated list of tile sizes is entered, and Griffin creates tiles of this size either from left
to right (if horizontal tiling) or top to bottom (if vertical tiling).

Comma-separated list of variable sizes [ st

None

No tiling is done in the specified dimension.
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6.3.

i Hr b
T
g o

T

2 Tiles

Vertically

Image tracing

The Griffin Image Tracing feature automatically generates precise cut tool paths around artwork
content in cases where no shape paths have been specified in the artwork.

Image Tracing is designed to be very fast while producing high quality shape tracings and works
equally well with artwork imported from image-based formats, PDF, and Al formats. There are
multiple settings providing fine-grained control over contour generation, and fast live previews
allow you to find the ideal settings quickly before applying.
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6.3.1. Generating a cut path

To generate a cut path from image contours
1. Inthe Artwork list, select the artwork piece you want to trace.
2. Inthe sidebar, switch to the Artwork properties tab as required.

3. Click the Image Tracing button.
The Image Tracing view opens where you can view a live preview of the generated cut tool
path.

4. In the sidebar on the right, change the settings to control the path generation as required.

For more info, refer to Image tracing settings on page 53.
5. To see the effect of your changes, click Preview.
6. Repeat the previous two steps until you're happy with the result.

7. To apply the new shape path to the artwork, click Apply.

Tip: Image tracing works well in conjunction with tool path editing in Artwork view where
you can make final tweaks to the generated tool paths if needed.

6.3.1.1. Image tracing settings

Settings Description

Tool Type Cutting tool type to use for the generated cut tool path.
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Settings Description

Raster Quality Quiality of the raster image to use for generating the cut tool path.
A value of 100% will rasterize the image at full size up to a limit of
10 megapixels. Lower values will scale the image down for faster
processing and in some case preferred results as less detail is used
for tracing.

Tolerance Amount of color difference to allow before adjacent colors are
considered different. A value of 0% means no tolerance in color
differences is allowed while 100% is the maximum allowed tolerance
in color differences.

Blur Radius The amount of blurring to apply to edges that are encountered
during edge detection. A higher blur radius means more blurring is
applied during edge detection which can lead to less jagged paths.

Simplify The amount of simplification to apply to the generated path. Simplify
works by removing points on the path that are within a certain
tolerance. A value of 0% disables path simplification while a value of
100% will use the highest allowed tolerance when removing points.

Smoothing Smoothing converts individual points on the generated path to
Bezier curves to produce smoother paths. A value of 0% disables
path smoothing while a value of 100% will perform the most
aggressive path curve smoothing.

Offset Additional offset distance to expand the generated path.

Preview Updates the generated path preview with the current settings.

6.4. Griffin keywords

Dynamic keywords are special text strings that are replaced with properties in artwork, layout,
job, date, or time. Keywords can be used in marks to create dynamic text marks and barcodes.
For example, you can create a QR code that encodes the artwork name or layout ID for use by
operators on the press floor.

Dynamic keywords can also be used to define properties for some export types and dynamic
filenames when creating printing and cutting files using Multiple Export.

6.4.1. Keywords overview

Below is a list of all keywords available in Griffin:

Keyword Description

<artwork.height> The height of the current artwork item.

<artwork.name> The name of the current artwork item.

<artwork.page-count> The total number of pages of the artwork file the current
artwork item came from.
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Keyword

Description

<artwork.page-number>

The page number of the artwork file the current artwork
item came from.

<artwork.path>

The filesystem path of the artwork file the current artwork
item came from.

<artwork.quantity>

The quantity of the current artwork item.

<artwork.tile>

The tile number for the current artwork item if this item was
created using the Tiling tool.

<artwork.tile-count>

The total number of tiles created if this item was created
using the Tiling tool.

<artwork.width>

The width of the current artwork item.

<date.iso>

The current date in ISO 8601 format. Example: 2024-01-26

<date.long>

The current date in long format. Example: January 26, 2024

<date.medium>

The current date in medium format. Example: Jan 26, 2024

<date.short>

The current date in short format. Example: 1/26/2024

<job.client>

The Client Name of the current job as defined in Job
Properties.

<job.contact>

The Contact Name of the current job as defined in Job
Properties.

<job.id>

The Job ID of the current job as defined in Job Properties.

<job.name>

The Job Name of the current job as defined in Job
Properties.

<job.notes>

The Notes of the current job as defined in Job Properties.

<layout.artwork-files>

A comma-delimited list of all artwork filenames being used
in the current layout.

<layout.copies>

The number of copies being produced of the current layout.

<layout.copy>

The current copy of the layout being printed.

<layout.dimensions>

The width and height of the current layout. Example: 800 x
1200 mm

<layout.index>

The index number of this layout. Numbering starts at 1.

<layout.name>

The name of this layout

<layout.placed>

The number of artwork items placed on this layout

<layout.random>

The unique random ID generated for this layout

<layout.side>

The current layout side: Front or Back

<layout.substrate>

The name of the substrate being used in the current layout

<layout.waste>

The percentage of waste on the current layout

<time.iso>

The current time in ISO 8601 format. Example: 21:30:49

<time.long>

The current time in long format. Example: 11:30:49 PM EST
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Keyword Description
<time.medium> The current time in medium format. Example: 11:30:49 PM
<time.short> The current time in short format. Example: 11:30 PM

6.5. Licensing

All variations of Phoenix and Griffin licenses are software based. In order to activate a license,
an internet connection is required. During activation the licensing server will be contacted over
HTTPS. This connection is secure and safe.

Once a standalone license is activated on a computer, it will be locked to that computer and
cannot be activated simultaneously on another workstation. This also applies to virtual machines,
which means a single license cannot be activated on a machine and then also activated on a VM
running on that machine.

6.5.1. License types

Trial license

Only valid either until a fixed expiry date, or for a specific trial period (which starts once the
license has been activated). For all trial licenses, an internet connection is required during start-up
to verify its authenticity.

Partner license (NFR)

Partner licenses are essentially the same as trial licenses, with the exception that they do not
require an internet connection at start-up to verify authenticity. This is particularly useful for
resellers who perform on-site demos with a laptop and tradeshows.

Subscription license

Subscription licenses are licenses generated for purchased copies of the software. They can
be used during the time of the subscription period, typically one year. Timely renewal of the
subscription will guarantee a smooth continuation of the use of the product under the same
software key.

6.5.2. Tilia Cloud licenses

Licenses of Griffin or Phoenix can be used with tilia Cloud. That means that the licenses
purchased by your organization can be managed, distributed and set up online, through the tilia
Cloud. The tilia Cloud administrator can create an unlimited number of users for the organization
and define exactly who can and can't have access to your licenses. Moreover, through tilia Could
it's also possible to use floating licenses, meaning that different users can use the same license
alternately.

Note: When licenses of Griffin or Phoenix are used with tilia Cloud, an active MSA and an
active tilia Cloud account are required.
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6.5.3. Upgrades

For Trial and Partner Licenses, upgrades are always valid.

For perpetual licenses, during start-up, it's verified that the license is valid for the current version
of the software. If the license is not valid for the current version, the software will attempt to
update the license by contacting the license servers. This process is automatic and requires no
manual intervention by the user.

If the license is covered under an MSA or the server has an updated copy of the license with
support for a newer version of the software, the upgrade will be successful.

If the license cannot be updated for the current version, the user will be required to downgrade
back to their previous version in order to continue using the software.

6.5.4. Deactivation

Local licenses, defined as those licenses distributed as a license key and not using tilia Cloud,
cannot be shared between multiple computers, and should be activated and used on one
dedicated computer. These licenses should be deactivated and moved to a different computer
only out of necessity.

In order to deactivate a license, an internet connection is required. Once a license has been
deactivated on a given computer, the softwware can no longer run on that workstation. This
process unlocks the license from the computer it was activated on, and the user is then free

to activate the license on a different workstation. Please note this feature is not intended as a
method to allow users to periodically use the software on different machines. There is a limit

to the number of times Griffin and Phoenix can be deactivated. If this limit is surpassed, the
customer or reseller will need to contact Enfocus in order to allow the license to be deactivated.

6.5.5. Computer failure

In the event of computer failure, please contact Enfocus to resolve the issue. We will manually
deactivate the license on the broken workstation, at which point the customer will be able to use
the same license on a new computer.

6.5.6. Remote desktop

Standalone licenses are not intended for use with remote desktop access. This essentially allows
customers to use a single standalone license as multiple licenses. We are not able to enforce this
for all remote desktop systems on the market, but it is against our policy and will violate the EULA
if customers utilize Phoenix or Griffin in this way.

6.5.7. Firewall/Proxy settings

If you are experiencing issues with connecting to our licensing server due to a firewall or proxy,
add an exclusion to your firewall or proxy settings to allow the following URLs on port 443:
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- engine.tilialabs.com

« engine2.tilialabs.com

« engine3.tilialabs.com

- engined4.tilialabs.com

« https://cloud.tilialabs.com
« https://api.tilialabs.com

« wss://stream.tilialabs.com

Alternatively, you can set a wildcard exception for any URLs ending in tilialabs.com.
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/. Griffin automation

/.1. About Griffin Auto

Griffin Auto allows you to run Griffin in an automated way, either via a RESTful API, complete
with Live Docs, or through the Griffin Switch App in Enfocus Switch.

Griffin Auto is a separate application from Griffin. If you need to use the User Interface, you'll want
to use the Griffin.app (or .exe). If you're automating, whether through Switch or the API, you'll want
to use Griffin Auto.

7.2. Griffin Auto REST AP

Manually starting the Griffin Auto API

To start the API, simply run the following command in Terminal, substituting your license for the
dummy example ABCDE-FGHIJ-KLMNO-PQRST-UVWXY:

MacOS:

/Applications/tilia\ Griffin\ Auto.app/Contents/MacOS/GriffinAuto -k ABCDE-FGHIJ-
KLMNO-PQRST-UVWXY

Windows:

"C:\Program Files\Tilia Labs\Griffin Auto\GriffinAuto.exe" -k ABCDE-FGHIJ-KLMNO-PQRST-
UVWXY

Note: Optionally you can run the command without the license key or with the -h flag to
show all available arguments for Griffin Auto.

Command line options

--datafolder
Optional custom data folder to place libraries and log files. When not
specified, a standard OS-dependent app data folder is used.

-h, --help
Print usage and exit
-i, --inactivity

Optional inactivity timeout in seconds. When set, this application will
exit when no new requests have been received within the given timeout
duration

-k, —-—key
License key when using key-based licensing

-1, --library
Optional path to library archive to load before server is started. If
not specified, the current library on this server is used.

-pw, -—--password
Tilia Cloud user password used to authenticate this server
-p, —--port

Optional TCP port number for the server to run on (default: 8022)
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—--—portscan
Whether to allow port scanning when specified port is not available.
Argument is a path to a file that the final port will be recorded into.
-u, --user
Tilia Cloud user name used to authenticate this server

After running with a valid license, the terminal will return the following:

WARNING: An illegal reflective access operation has occurred

WARNING: Illegal reflective access by org.codehaus.groovy.reflection.CachedClass$3$1
(file:/Applications/tilia%20Griffin%20Auto.app/Contents/Java/groovy-all-1.8.5.jar) to
method java.lang.Object.finalize ()

WARNING: Please consider reporting this to the maintainers of
org.codehaus.groovy.reflection.CachedClass$3$1

WARNING: Use --illegal-access=warn to enable warnings of further illegal reflective
access operations

WARNING: All illegal access operations will be denied in a future release

Jun 15, 2022 9:56:38 AM org.glassfish.grizzly.http.server.NetworkListener start

INFO: Started listener bound to [0.0.0.0:8022]

Jun 15, 2022 9:56:38 AM org.glassfish.grizzly.http.server.HttpServer start

INFO: [HttpServer] Started.

ﬂ Note:

You can ignore the warnings, and find the address where Griffin Auto is running. By
default, this is

localhost:8022 or 0.0.0.0:8022. If you visit that address in the browser, you can visit the
open API live documentation for Griffin Auto.
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/.3. Griffin Auto through Switch

If you are running Griffin through Enfocus Switch, you simply need to download and install the
Griffin Auto application, then control everything through the Griffin Switch App.

Note: You do not need to manually start the Griffin REST API.

Documentation and sample flows can be found on the Griffin App page on the Enfocus Appstore.

7.3.1. Getting started with the Griffin app

Before you start, make sure to obtain a valid license for Griffin Auto.

To get started with the Griffin App in Switch, proceed as follows

1. Run the installer to install Griffin Auto.

Note:

« Make sure you install Griffin Auto on the same computer that Enfocus Switch is
running on.

« IMPORTANT: When upgrading from tilia Griffin Auto 2.2 to Enfocus Griffin Auto
24.03 or later, make sure to manually remove the old tilia Griffin Auto application
from your computer.

- Note that Griffin 24.03 is NOT compatible with version 3 of the Griffin app. You
need version 4 or later.

2. Download and install the free Griffin Switch App from the Enfocus Appstore:
a. Browse to https.//www.enfocus.com/en/appstore/product/griffin.

Click Get it now.

Select the Switch installation(s) on which you want to use the app.

Click Start free app.

e o

o

Go to Switch and, in the Flow elements pane, click the Refresh apps icon. ‘i/
The Griffin app can be found in the Apps section of the Flow elements pane.

3. Create a new flow in Switch and drag and drop the Griffin app onto the canvas.

Note: To learn how to work with Switch, refer to the eLearning and the
documentation on the Enfocus website.

4. Configure the properties of the Griffin app.

Note: You need to enter a valid Griffin Auto license key into the License key
property in every instance of the Griffin app. Also, if you installed Griffin Auto to a
custom location during the install process, you will need to specify the install location
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by setting the "Install location" property to "Custom" and selecting your custom install
directory in the "Install folder" property.

For an overview of all properties, refer to Griffin app documentation

7.3.2. Griffin app documentation

7.3.2.1. Griffin

G

Griffin Auto packs many features into a single solution, giving you an automation toolbox for
stepping up, image tracing, tiling, nesting, and ganging your artwork onto sheets or rolls and
generating production ready output for your printers and cutters.

The Griffin app gives you full access to the power of Griffin Auto. This app contains over 300
properties. Detailed descriptions of all properties are found below. Each property also has
detailed tooltips in Switch. We recommend utilizing them as you work with the app.

Almost all properties can be set using variables and script expressions to utilize the rich set of
data available in Switch like job properties, folder hierarchies, metadata fields, and database

entries.
‘ Cutting
T
B @) — (3
Input Griffin Print output Log copies Printing
o
Griffin jobs
Errors
Compatibility

Switch 17 update 1 and higher
Compatibility third-party application

This app relies on the presence of Griffin Auto 2.2 or higher (including Griffin Auto 24.03). Griffin
Auto must be installed on the same computer running Switch and a valid license is required.
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Input files

The Griffin app collects artwork files from a single input connection until certain trigger event(s)
occur at which point the files are processed. The app supports PDF and PDF-based Al formats as
well as TIFF, PNG, BMP, JPG, and GIF image formats.

The input handling logic is similar to the built-in "Assemble job" flow element. You can wait for N
or more files to enter the input folder or wait N minutes after the first file has arrived. In Advanced
mode you can also write a custom trigger condition, and control which artwork files are to be
included together during processing by using a trigger identifier. More details about triggers are
found in Advanced Mode, described in depth below.

Connections

You can create as many outgoing connections as you like. For each connection you can choose
whether to generate output files or to send along input files using the Data property.

Data property - Chosen value Description

Output files

When selecting "Output files" for the Data property you are presented with
options to output for printing, output for cutting, output job file. One or more of
these options must be selected within a single connection to produce output.

Output for printing Generates imposed PDF(s) of the layouts generated by
Griffin. When enabled, there are properties to control
whether to produce a single multi-page PDF or separate
PDFs for each layout and whether to create a separate PDF
page for each copy required. Other options include whether
to remove tool paths from the original artwork and whether
to use PDF 1.6 UserUnit for layouts above 200 inches in
width or height.

Output for cutting Generates vector PDF, DXF, or Zund Cut Center (ZCC)
cutting output containing all tool paths in the imposed
layout(s). For PDF output, you can choose whether to
generate a single cutting file containing all generated
layouts, or individual PDF files for each layout. Other options
include which marks to include in output and how to map
tool types to colors and layer names.

Output job file When enabled, a Griffin job file, GFN, will be created. This
allows you to open the job in the Griffin desktop application
to do further adjustments to layouts if needed. This option
is also useful for archiving the generated layouts for future
reprint or revision update.

XML dataset name The app will attach an external XML dataset to each file
created on the given output files connection. This XML
data contains information about how many layout copies
are required to produce, which artwork files were placed
on each layout, and other statistics about each layout like
sheet usage. The XML dataset name property allows you to
customize the name of this dataset.

Input files
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Data property - Chosen value

Description

When selecting "Input files" for the Data property you can select which scenario
you want to send input files through this connection via the Move property.

Move

Options:

» On Error: This is the most common use case. When
this option is selected, only input files that could not be
placed in layouts are sent to this connection. The most
common scenario is artwork files that are too big to fit on
the board or roll. If no "On error" connection has been
setup, these input files are sent to the Problem jobs
folder. In either scenario, the error is logged in Messages.

« On success: Only input files that were successfully
placed in layouts will be sent to this connection.

« Always: All input files, regardless of success or failure,
will be sent to this connection. Note that error situations
are still logged as errors in Messages.

Note: If there are no matching input files
connections for a given input file, it will be deleted.

App properties detailed info (high-level properties)

Properties Description

Job ID ID of the job

Units Indicates which units are used.
Install location Location

License type Options are:

« License key (key)
« Cloud License (User ID & Password)

Mode

With so much functionally packed into the app,
there are over 220 flow element properties
total. To make it easy to get started with the
app, there are two modes to choose from:

« Basic Mode: Basic mode provides a minimal
set of 12 high-level properties.
« Advanced Mode

See below for a full description.

Basic mode

The table below lists the subproperties available in Basic Mode.

Basic mode provides a minimal set of 12 high-level properties. Even with this limited subset, you
can create print-ready layouts on rolls or boards while controlling rotation, sheet margins, and the
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cutting tool paths. You can also include and customize dynamic barcodes, camera marks, and
text marks.

Basic mode always performs free nesting appropriate for cutting tables. Barcodes are always
placed in the upper-left corner of the layout while text marks are placed in the center of the
top edge. There is some control over mark content while Advanced mode provides many more
properties.

Basic Mode Properties Description

Trigger every N files The total number of artwork files needed
before starting processing in Basic mode. An
empty or O value disables this option.

Trigger after N minutes Start processing current set of artwork pieces
N minutes after first artwork arrived in Basic
mode regardless of whether required number
of artwork pieces has been reached. An empty
or O value disables this option.

Substrate Select the substrate type you need (predefined
board or roll size to use for imposition).

Margin Enter the required margin. Distance from
bottom

Quantity Enter the required quantity.

Rotation Options are:

« Any
« Orthogonal
+ None

Cutting tool Enter the required cutting tool.

Barcode Select a barode. Options are:

« Code 39

« Code 128
« QR Code
« None

You also have to specify the data you want to
use for the barcode. Select the option of your
choice: Layout random ID, Layout name, Layout
index, Layout dimensions, Job ID, Date (ISO or
long format), Time (ISO or long format).

Camera marks Options are:

« None

. Corners

« Auto distribute

« Corners and Auto distribute

You also need to specify the quantity.

Text mark Select the option of your choice: None, Layout
random ID, Layout name, Layout index, Layout
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Basic Mode Properties Description

dimensions, Job ID, Date (ISO or long format),
Time (ISO or long format).

Advanced mode

Due to the number of limitations in Basic mode, most users will opt to use Advanced mode
instead which gives you full control of all features in the Griffin app. Below is a list of Advanced
mode capabilities beyond what is possible in Basic mode:

« Artwork tiling

« Artwork scaling

- Image tracing for automatic cut line generation

« Artwork and board flutes directions

« Multi-page handling options

« Artwork front repeat or mirror to back

- Artwork barcode, text, fill, and grommet marks

« Nest for guillotine cutters or cutting tables

« Custom roll and board sizes

« Turn vs. tumble for double-sided layouts

« Custom trigger conditions

- Trigger identifiers to control which artwork files are processed together
- Up to four different tool types can be imported at a time

« Content margins defined independently for each sheet edge

- Options to control artwork bleed clipping path offsets and spacing
« Mark position and other mark customization options

Advanced mode properties are classified into three categories - Trigger conditions, Layout
properties, and Artwork properties. Each category is represented by a read-only property with
all related properties defined as child nodes of the property.

Trigger conditions

Trigger conditions define when artwork files being collected in the input folder are processed

by Griffin. You can trigger processing when N or more files arrive, N minutes after the first file

has arrived, or on a custom trigger condition. You can also control which artwork files are to be
included together during processing by using a Trigger identifier. When multiple trigger condition
properties are configured, the first trigger event that occurs will cause all input jobs with the same
trigger identifier value to be processed.

Advanced mode - Trigger Description

conditions

Trigger every N files The total number of artwork files needed before starting
processing in Advanced mode. An empty or O value disables this
option.

Trigger after N minutes Start processing current set of artwork pieces N minutes after

first artwork arrived in Advanced mode regardless of whether
required number of artwork pieces has been reached. An empty
or O value disables this option.

Trigger on condition Processing is started whenever this condition is true regardless
of whether N files or N minutes rules have been met. This
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Advanced mode - Trigger Description
conditions

condition is re-evaluated for each new job in the context of that
job. A value of None means this option is disabled.

Trigger identifier A string value evaluated in the context of each incoming job that
determines which artwork files should be processed together. If
set, Griffin will include only jobs with the same Trigger Identifier
and the "Trigger every N files" and "Trigger after N minutes"”
properties will only consider other jobs with the same Trigger
identifier value when determining whether procesing should
start. A value of None means this option is disabled.

Layout properties

Layout properties control how artwork pieces are placed on layouts, substrate type and sizes,
double sided handling, margins, and layout placement.

Note: Barcode and text mark have options for using dynamic keywords.

Advanced mode - Layout Description

properties

Strategy This option dictates the kind of layouts that are created. Options
are:

« Free nesting: This is the most aggressive nesting strategy
and is ideal for cutting tables.

« Grid nesting: This also nests irregular shapes while keeping
same shaped items together on the sheet in step and repeat
groups.

- Guillotine: This will place pieces in strips that can be cut out
with a guillotine cutter. This strategy triggers a subordinate
property: First cut: This is the direction of the first cut, either
Horizontal, Vertical or Either.

Rotation Rotation along with Flutes for board substrates and the Flutes
property in Artwork properties control the allowed rotations for
artwork pieces in the layout. Options are:

« Any: This option lets artwork pieces be placed at any angle
unless the artwork and board both have flutes directions
in which case only rotations that align flutes directions are
allowed.

« Orthogonal: This type of rotation allows 0, 90, 180, and 270
degree rotations unless flutes need to be honored.

« None: This will ensure that artwork pieces are not rotated on
the layout.

Allow multiple layout copies | Indicates whether or not to allow multiple copies of layouts
generated by the nesting tool.
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Advanced mode - Layout Description

properties

Substrate type Type of substrate to nest onto. Options are:
- Board
+ Roll

Subordinate properties are:

- Width: Width of board or roll to nest artwork onto.

« Height. Height of board to nest artwork onto.

« Flutes: Flutes direction of board if any. Long means flutes run
in the direction of the long edge of the board, while Short
means flutes run along the short edge of the board.

« Min roll cut-off: Min roll cutoff height.

« Max roll cut-off: Max roll cutoff height.

« Name: Optional name of substrate used in reporting and
Zund Cut Center (ZCC) cutting output.

- Thickness: Optional substrate thickness. Thickness is
included in reporting and Zund Cut Center (ZCC) cutting
output to automatically match the substrate with the
corresponding material in Zund Cut Center.

Double sided Work style when handling double-sided work.

Horizontal placement Horizontal position on the layout to align nested artwork pieces.
Vertical placement Vertical position on the layout to align nested artwork pieces.
Top margin Amount of space on top edge of layout to ensure that no artwork

pieces are placed into in Advanced mode.

Bottom margin Amount of space on bottom edge of layout to ensure that no
artwork pieces are placed into in Advanced mode.

Left margin Amount of space on left edge of layout to ensure that no artwork
pieces are placed into in Advanced mode.

Right margin Amount of space on right edge of layout to ensure that no
artwork pieces are placed into in Advanced mode.

Camera marks Whether or not to add camera marks to each generated layout in
Advanced mode.

If set to Yes, a number of subordinate properties are shown:

« Shape: Shape of the camera marks: circle or cross. This
triggers the following properties:

« Stroke color: Camera mark stroke color. Cyan/Magenta/
Yellow/Black component of custom color from O to 100 for
camera mark stroke color. In case of a spot name: optional
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Advanced mode - Layout
properties

Description

spot name for camera mark stroke color. When specified,
this custom color is treated as a spot color instead of a
process color.

« Stroke thickness: Camera mark stroke thickness
« Fill color (only for circle marks): Camera mark fill color.
« Size: The size of each camera mark instance.

- Layer: Optional layer name for this camera mark. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

« Min distance: The minimum distance to place camera marks
from the shape of items in the layout.

- Add corners: Whether to place camera marks in the four
corners of the layout. This triggers:

« Double corner: Whether to include a second corner mark
in the lower-right corner of the layout. If enabled, the
second corner mark is placed to the left of the right corner
mark by the double corner offset. If enabled, this triggers
Double corner offset: Distance to place the second corner
mark from the lower-right corner mark.

« Margins:

- Use Layout margins to ensure camera marks are not
placed outside the allowed content region of the layout.

« Use Custom margins to define custom distances from
each sheet edge where camera marks can be placed.

« Mirror to back: When enabled, camera marks are
automatically mirrored to the back side of the layout. This is
useful for cases when the layout will be getting cut face down
on the cutting table.

- Auto distribute: Mode to use to automatically place camera
marks throughout the layout. Options are:

« None: Only corner camera marks are placed.

« Spacing: A minimum spacing distance is used.

« Quantity: A specific number of marks is added. This
quantity is not guaranteed since there are situations
where space is too limited.

Barcode

Whether or not to add a barcode mark to each generated layout
in Advanced mode.

Following options are triggered:
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properties

« Fill color: Layout barcode color. Cyan/Magenta/Yellow/Black
component of custom color from O to 100 for layout barcode
fill color. In case of a spot name: optional spot name for
layout barcode fill color. When specified, this custom color is
treated as a spot color instead of a process color.

« Layer: Optional layer name for this layout barcode. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

- Format: Layout barcode format type. This triggers Show
human-readable: If enabled, plain text of the barcode content
is included below the barcode for 1D barcode formats such as
Code 39 and Code 128.

« Data: Dynamic keyword for barcode content or any custom
text when using the 'Custom' option in Advanced mode. Each
keyword option has a corresponding text value that can be
used and combined in the custom text value. See Dynamic
keywords table below.

« Scale: Scale factor to apply to the layout barcode to increase
or decrease its size. The default value of 1.0 signifies 100%
meaning no scaling is performed on the barcode.

« Mark reference point. Reference point in this layout barcode
to align layout placement point to.

« Layout reference point. Point within layout to place barcode
mark alignment point to.

« Horizontal offset. Additional horizontal offset to move the
layout barcode from the placement point. Positive scalar
values move the barcode to the right while negative values
move the barcode to the left within the layout.

- Vertical offset. Additional vertical offset to move the layout
barcode from the placement point. Positive scalar values
move the barcode up while negative values move the
barcode down within the layout.

« Rotation: Rotation of the barcode in the layout.

Text mark Whether or not to add a text mark to each generated layout.

« Color: Layout text mark color. Cyan/Magenta/Yellow/Black
component of custom color from 0 to 100 for layout text
mark. In case of a spot name: optional spot name for layout
text mark. When specified, this custom color is treated as a
spot color instead of a process color.
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Advanced mode - Layout
properties

Description

« Layer: Optional layer name for this layout text mark. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

. Text: Dynamic keyword for layout text content or any custom
text when using the 'Custom' option in Advanced mode. Each
keyword option has a corresponding text value that can be
used and combined in the custom text value. See Dynamic
keywords table below.

- Font: Name of font to use in this layout text mark. Use 'Select
from library' to view a list of available fonts.

- Font size: Size of text in points (pt) for this layout text mark.

- Font style: Font style of layout text mark. Note that some
fonts do not support all styles. When a style is chosen that
is not available for the given font, the style will default to
Normal and a warning message will be logged in Switch.

- Mark reference point. Reference point in this layout text mark
to align layout placement point to.

- Layout reference point. Point within layout to place layout
text mark alignment point to.

« Horizontal offset. Additional horizontal offset to move the
layout text mark from the placement point. Positive scalar
values move the mark to the right while negative values
move the mark to the left within the layout.

- Vertical offset. Additional vertical offset to move the mark
from the placement point. Positive scalar values move the
layout text mark up while negative values move the mark
down within the layout.

« Rotation: Rotation of layout text mark within layout

Border mark

Whether or not to add a border mark to each generated layout.

« Stroke color: Border mark stroke color. Cyan/Magenta/
Yellow/Black component of custom color from O to 100 for
layout border mark. In case of a spot name: optional spot
name for layout border mark. When specified, this custom
color is treated as a spot color instead of a process color.

« Stroke thickness: Stroke thickness of border lines.
« Fill color: Border mark fill color. Cyan/Magenta/Yellow/Black

component of custom color from 0 to 100 for layout border
mark. In case of a spot name: optional spot name for layout
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Advanced mode - Layout Description
properties

border mark. When specified, this custom color is treated as a
spot color instead of a process color.

« Layer: Optional layer name for this border mark. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

. Top: Distance from the top edge of the sheet in the
downward direction to draw the top edge of the border mark.

- Bottom: Distance from the bottom edge of the sheet in the
upward direction to draw the bottom edge of the border
mark.

« Left: Distance from the left edge of the sheet in the right
direction to draw the left edge of the border mark.

« Right: Distance from the right edge of the sheet in the left
direction to draw the right edge of the border mark.

Corner mark Whether or not to add a corner mark to each generated layout.

« Stroke color: Corner mark stroke color. Cyan/Magenta/
Yellow/Black component of custom color from O to 100 for
layout corner mark. In case of a spot name: optional spot
name for layout corner mark. When specified, this custom
color is treated as a spot color instead of a process color.

« Stroke thickness: Stroke thickness of corner mark lines.

« Layer: Optional layer name for this layout corner mark. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

« Corner type: Corner mark flavors: Type 1 or Type 2. Both
types are simple "L" shaped stroked marks, with Type 1
corner marks facing towards the layout and Type 2 facing
outwards.

« Width: Width of each corner mark, i.e. the distance from the
corners to extend the horizontal lines.

« Height. Height of each corner mark, i.e. the distance from the
corners to extend the vertical lines.

« Horizontal distance: Optional distance to offset the corner
mark in the horizontal direction. Positive values will move the
corner point away from the layout while negative values will
move the corner point inside the layout.

- Vertical distance: Optional distance to offset the corner mark
in the vertical direction. Like Horizontal Distance, positive
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values will move the corner point away while negative values
with move the corner point inside the layout.

Shape mark Whether or not to add a rectangular shape mark to each
generated layout.

« Stroke color: Shape mark stroke color. Cyan/Magenta/Yellow/
Black component of custom color from O to 100 for layout
shape mark. In case of a spot name: optional spot name
for layout shape mark. When specified, this custom color is
treated as a spot color instead of a process color.

. Stroke thickness: Stroke thickness of shape mark lines.

« Fill color: Shape mark fill color. Cyan/Magenta/Yellow/Black
component of custom color from O to 100 for layout shape
mark. In case of a spot name: optional spot name for layout
shape mark. When specified, this custom color is treated as a
spot color instead of a process color.

« Layer: Optional layer name for this layout shape mark. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

« Width: Width of each rectangular shape mark.
« Height: Height of each rectangular shape mark.

« Mark reference point. Reference point in this layout shape
mark to align layout placement point to.

« Layout reference point. Point within layout to place layout
shape mark alignment point to.

« Horizontal offset. Additional horizontal offset to move the
layout shape mark from the placement point. Positive scalar
values move the mark to the right while negative values
move the mark to the left within the layout.

« Vertical offset. Additional vertical offset to move the layout
shape mark from the placement point. Positive scalar values
move the mark up while negative values move the mark
down within the layout.

« Rotation: Rotation of layout shape mark within the layout.

Artwork properties

Artwork properties control how each individual artwork file is handled in Griffin. Here you can
define the order quantity, flutes direction, cutting tools mappings from PDF paths, bleed mask
offsets, and placement spacing.
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You can also optionally scale the artwork using the Scaling property. Scaling can be defined as a
percentage of the original size or a fixed size.

Artwork properties also include the Multi-page file handling property that allows you to control
how to interpret multi-page artwork files. "One item per two pages" will interpret even numbered
pages as the back side content of the previous page. "One item per page" will treat each page as
a different single-sided artwork piece and gives you the option of duplicating the artwork to the
back or mirroring the front to the back with the Back side content child property.

Artworks properties also include the options to add a Barcode, Text, Corner, Grommet, and Fill
marks to the artwork. Like layout marks, each mark type has several child properties controlling

content, placement, and color.

Advanced mode - Artwork Description

properties

Quantity Order quantity for this artwork.
Flutes Flutes direction of this artwork if any.

Multi-page file handling

This option affects how multi-page artwork files are interpreted.
Options are:

« One item per page This option triggers Back side content:
Content to use for back side if any. Front artwork can be
duplicated on back or mirrored to back.

« One item per two pages This is the best option if you work
with two page artwork files containing the front and back
sides of the artwork files.

Shape handling

Shape handling mode to use when finding closed path shapes
from the dielines in the artwork. Options are:

« Largest

« Multiple: This mode will create a new artwork item for each
closed path shape detected in the artwork.

Default cut tool

Main tool being used to cut artwork item. Depending on the
chosen tool, following subordinate properties are displayed:

. Spot color names: List of names to match with spot color
names in the artwork that define paths for default cut tool
type. Matching is case insensitive.

« Layer names: List of names to match with layer names in the
artwork that identify paths for default cut tool type. Matching
is case insensitive.

« Text match: Type of text matching to use for default cut tool.
'Equals' matches the text exactly with the spot or layer name,
'StartsWith' matches the text with the beginning of the name,
and 'Contains' matches the text with any portion of the name.

« Cutting width: Width of the main cutting tool. This property

can be used to define the spacing distance between items
the Nesting Tool uses when the artwork item spacing type is
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properties
set to 'Tool' to ensure the cutting tool does not affect other
items in the layout.

- Offset. Optional scalar offset to apply to the shape for the
default cut tool. Negative offset values will cause the shape to
be reduced while positive values will increase the shape size.

- Join style: The style used to join path segments in the shape
when a cutting offset is applied for the default cut tool. If set
to Miter, Miter limitis triggered: For Cut category tools with
a cutting offset and 'Miter' join style, this limit defines the
distance beyond the end of the joined path segments where
mitering is clipped to avoid long spikes on sharp corners.

Additional tool 1-3 Optional tools to define in addition to the default cut tool when
more than one tool is used with the artwork. For a description of
the subordinate properties, refer to the explanation of 'Default
cut tool'".

Scaling Whether to scale the artwork to make the content and shape
bigger or smaller. Scaling can be defined by percentage of
original artwork shape size or by specific dimensions.
Subordinate properties:

- Width: Horizontal scaling defined as percent of original
artwork width. For example, 50% is half of the original artwork
shape width while 100% results in no scaling. Percent sign '%'
is not required.

« Height: Vertical scaling defined as percent of original artwork
height. For example, 50% is half of the original artwork shape
height while 100% results in no scaling. Percent sign '%' is not
required.

« Scale proportionally: When either width or height are not
specified, this property controls whether the unspecified
dimension is scaled proportionally to the other dimension.
When turned off, only the dimension that is specified is
scaled.

Bleed Type of bleed mask to apply to this artwork piece's content:

« Offset: This option creates a uniform offset path from the
artwork piece shape. You must determine the exact offset:
offset from artwork piece shape to generate bleed clipping
mask with. As with all other scalar value properties, units may
be specified (e.g. 3mm) and if omitted, the default units are
assumed

« None will not apply a bleed mask.

Spacing Artwork piece spacing type used when placing piece in layouts
during nesting. Options:
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Advanced mode - Artwork Description
properties
- Bleed
- Offset: This option triggers a property Offsetwhere you can
specify the amount of offset. As with all other scalar value
properties, units may be specified (e.g. 3mm) and if omitted,
the default units are assumed.
+ Tool
Tiling Tiling mode for artwork:

« None: This option disables tiling.

- Direct: Allows you to define properties to control tiling
behavior in the horizontal and vertical directions. This option
triggers the following subordinate properties:

« Start corner: The corner of the artwork where the first tile
is to be placed. This property plus tile order define the
exact order tiles are to be placed.

« Tile order: Tile placement order. This property plus start
corner define the exact order tiles are to be placed.

« Horizontal tiling: Rule for splitting up artwork into tiles in
the horizontal direction. Used to divide the artwork into
multiple items to be produced separately. Depending on
the chosen option, following subordinate properties are
shown:

«  Number of tiles: Number of tiles to create in the
horizontal direction. Tiles are evenly spaced across the
width of the artwork.

« Uniform final size: When defining a fixed number of
tiles, enabling this option ensures the final tile sizes are
uniform in the horizontal direction regardless of gap or
overlap settings. When not enabled, inner and edge
tile sizes can differ because uniform tile sizes are then
calculated before gap or overlap rules are applied.

« Tile width: Fixed width of tiles in horizontal direction.

« Tile widths: List of all tile widths in the horizontal
direction.

« Tiling method: Tiling method to use in horizontal
direction in any: Gap or Overlap.

- Gap: Gap distance between tiles in the horizontal
direction.
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properties

. Extension: Amount of extra artwork content beyond
the tile gap edge to extend in the horizontal
direction.

- Extension direction: Rule defining which horizontal
direction(s) the gap is extended for each tile.

- Overlap: Distance beyond tile edge to extend the
tile horizontally to create overlap.

« Overlap rule: Rule defining what horizontal edge(s)
of tiles will overlap with neighboring tiles.

« No-image: Width of the section at the end of the
overlap where no artwork content is allowed. This
no image section can be used for example to create
a glue strip area on the tile piece.

- Vertical tiling: See Horizontal tiling. Same properties but in
the vertical direction.
Image tracing Whether to perform image tracing on the artwork to automatically

generate precise cut paths around artwork content. If enabled,
following subordinate properties are enabled:

« Tool type: Name of the cutting tool to use for the generated
cut tool path.

» Raster quality: Quality of the raster image to use for
generating the cut tool path from 1to 100. A value of 100 (i.e.
100%) will rasterize the image at full size up to a limit of 10
megapixels. Lower values will scale the image down for faster
processing and in some case preferred results as less detail is
used for tracing.

« Tolerance: Amount of color difference to allow before
adjacent colors are considered different. A value of O means
no tolerance in color differences is allowed while 100 is the
maximum allowed tolerance in color differences.

« Blur radius: The amount of blurring to apply to edges that are
encountered during edge detection between 0 and 100. A
higher blur radius means more blurring is applied during edge
detection which can lead to less jagged paths.

- Simplify: The amount of simplification to apply to the
generated path. Simplify works by removing points on the
path that are within a certain tolerance. A value of O disables
path simplification while a value of 100 will use the highest
allowed tolerance when removing points.
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- Smoothing: Smoothing converts individual points on the
generated path to Bezier curves to produce smoother paths.
A value of O disables path smoothing while a value of 100 will
perform the most aggressive path curve smoothing.

- Offset. Additional offset distance to expand the generated
path.

Barcode Whether or not to add a barcode mark to this artwork piece.

Following options are triggered:

« Fill color: Artwork barcode color. Cyan/Magenta/Yellow/
Black component of custom color from O to 100 for artwork
barcode fill color. In case of a spot name: optional spot name
for artwork barcode fill color. When specified, this custom
color is treated as a spot color instead of a process color.

« Layer: Optional layer name for this artwork barcode. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

« Format: Artwork barcode format type. This triggers Show
human-readable: If enabled, plain text of the barcode content
is included below the barcode for 1D barcode formats such as
Code 39 and Code 128.

« Data: Dynamic keyword for barcode content or any custom
text when using the 'Custom' option in Advanced mode. Each
keyword option has a corresponding text value that can be
used and combined in the custom text value. See Dynamic
keywords table below.

« Scale: Scale factor to apply to the artwork barcode to
increase or decrease its size. The default value of 1.0 signifies
100% meaning no scaling is performed on the barcode.

« Artwork reference point. Reference point in this artwork
barcode to align artwork placement point to.

« Artwork reference point. Point within artwork to place
barcode mark alignment point to.

- Horizontal offset. Additional horizontal offset to move the
artwork barcode from the placement point. Positive scalar
values move the barcode to the right while negative values
move the barcode to the left within the artwork.

- Vertical offset. Additional vertical offset to move the artwork
barcode from the placement point. Positive scalar values
move the barcode up while negative values move the
barcode down within the artwork.
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« Rotation: Rotation of the barcode in the artwork.

Text mark Whether or not to add a text mark to this artwork.

« Color: Artwork text mark color. Cyan/Magenta/Yellow/Black
component of custom color from 0 to 100 for artwork text
mark. In case of a spot name: optional spot name for artwork
text mark. When specified, this custom color is treated as a
spot color instead of a process color.

« Layer: Optional layer name for this artwork text mark. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

« Text: Dynamic keyword for artwork text content or any custom
text when using the 'Custom' option in Advanced mode. Each
keyword option has a corresponding text value that can be
used and combined in the custom text value. See Dynamic
keywords table below.

« Font: Name of font to use in this artwork text mark. Use
'Select from library' to view a list of available fonts.

« Font size: Size of text in points (pt) for this artwork text mark.

« Font style: Font style of artwork text mark. Note that some
fonts do not support all styles. When a style is chosen that is
not available for the given font, the style will default to Normal
and a warning message will be logged in Switch.

« Mark reference point:. Reference point in this artwork text
mark to align artwork placement point to.

« Artwork reference point. Point within artwork to place artwork
text mark alignment point to.

« Horizontal offset. Additional horizontal offset to move the
artwork text mark from the placement point. Positive scalar
values move the mark to the right while negative values move
the mark to the left within the artwork.

- Vertical offset. Additional vertical offset to move the mark
from the placement point. Positive scalar values move the
artwork text mark up while negative values move the mark
down within the artwork.

« Rotation: Rotation of artwork text mark within the artwork.

Corner mark Whether or not to add a corner mark to this artwork piece.
Subordinate properties are:

« Stroke color: Corner mark stroke color. Cyan/Magenta/Yellow/
Black component of custom color from O to 100 for artwork
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corner mark. In case of a spot name: optional spot name for
artwork corner mark. When specified, this custom color is
treated as a spot color instead of a process color.

« Stroke thickness: Stroke thickness of corner mark lines.

- Layer: Optional layer name for this artwork corner mark. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

« Corner type: Corner mark flavors: Type 1 or Type 2. Both
types are simple "L" shaped stroked marks, with Type 1
corner marks facing towards the artwork and Type 2 facing
outwards.

« Width: Width of each corner mark, i.e. the distance from the
corners to extend the horizontal lines.

« Height: Height of each corner mark, i.e. the distance from the
corners to extend the vertical lines.

« Horizontal distance: Optional distance to offset the corner
mark in the horizontal direction. Positive values will move the
corner point away from the artwork while negative values will
move the corner point inside the artwork.

- Vertical distance: Optional distance to offset the corner mark
in the vertical direction. Like Horizontal Distance, positive
values will move the corner point away while negative values
with move the corner point inside the artwork.

Grommet marks Whether or not to add grommet marks to this artwork piece.
Subordinate properties are:

« Stroke color: Artwork grommet mark color. Cyan/Magenta/
Yellow/Black component of custom color from O to 100 for
artwork grommet mark color. In case of a spot name: optional
spot name for artwork grommet mark. When specified, this
custom color is treated as a spot color instead of a process
color.

« Stroke thickness: Stroke thickness of grommet mark lines.

« Layer: Optional layer name for this artwork grommet mark.
When specified, the mark's content will be placed in a PDF
layer with the given name during export.

« Shape: Shape of each grommet mark (Target, Cross, Circle).
You must also determine the size (width and height of each
grommet mark instance) and the circle diameter (= this is the
diameter of the inner circle in Target shape grommet marks).
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« Margin: The margin offset to place grommet marks from the
bounds of the artwork.

« Hem: The width of the hem for artwork grommet marks.

« Marks on hem: If enabled, grommet marks are mirrored onto
the hem so they line up when the edges are folded.

- Spacing type: This property controls how artwork grommet
marks are distributed across the edges.
« Max spacing will evenly place marks as far apart as

possible up to the max spacing distance.

« Quantity will place the exact number of marks defined in
the horizontal and vertical quantity properties.

- Top edge/bottom edge/left edge/right edge: Whether to add
grommet marks to the specified edge of the artwork.

Fill mark Whether or not to add a fill mark to this artwork piece.
Subordinate properties are:

« Color: Fill mark color. Cyan/Magenta/Yellow/Black component
of custom color from 0 to 100 for artwork fill mark color. In
case of a spot name: optional spot name for artwork fill mark.
When specified, this custom color is treated as a spot color
instead of a process color.

« Layer: Optional layer name for this artwork fill mark. When
specified, the mark's content will be placed in a PDF layer
with the given name during export.

« Margin: Margin offset from the artwork piece shape to create
the fill mark

Dynamic keywords that can be used for barcodes (overview)

Value Keyword Description

Date ISO format <date.iso> The current date in ISO 8601 format
Example: 2024-01-26

Date long format <date.long> The current date in long format

Example: January 26, 2024

Date medium format <date.medium> The current date in medium format

Example: Jan 26, 2024

Date short format <date.short> The current date in short format

Example: 1/26/2024
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Job ID <job.id> The Job ID of the current job as defined in
Job Properties

Time ISO format <time.iso> The current time in ISO 8601 format

Example: 21:30:49

Time long format

<time.long>

The current time in long format

Example: 11:30:49 PM EST

Time medium format

<time.medium>

The current time in medium format

Example: 11:30:49 PM

Time short format

<time.short>

The current time in short format

Example: 11:30 PM

Following keywords apply to layouts (not available in the Artwork properties)

Layout copies

<layout.copies>

The number of copies being produced of
the current layout.

Layout current copy

<layout.copy>

The current copy of the layout being
printed

Layout dimensions

<layout.dimensions>

The width and height of the current layout
Example: 800 x 1200 mm

Layout index

<layout.index>

The index number of this layout

Numbering starts at 1.

Layout name

<layout.name>

The name of this layout

Layout placed

<layout.placed>

The number of artwork items placed on
this layout

Layout random ID

<layout.random>

The unique random ID generated for this
layout

Layout side

<layout.side>

The current layout side: Front or Back

Layout waste

<layout.waste>

The percentage of waste on the current
layout

Layout width

<layout.width>

The width of the layout

Layout height

<layout.height>

The height of the layout

Following keywords apply to artwork (not available in the Layout properties)

Artwork name

<artwork.name>

The name of the artwork

Artwork quantity

<artwork.quantity>

The quantity of the artwork

Artwork width

<artwork.width>

The widht of the artwork

Artwork height

<artwork.height>

The height of the artwork

Artwork path

<artwork.path>

The filesystem path of the artwork file the
current artwork item came from.
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Keyword

Description

Artwork page number

<artwork.page-number>

The total number of pages of the artwork
file the current artwork item came from.

Artwork page count

<artwork.page-count>

The total number of pages of the artwork
file the current artwork item came from.

Dealing with errors

There are a few different types of errors that can occur in the Griffin Switch App. The best way to
find out what is causing an error is to look to the Griffin log file, found here:

« On MacOSs:

Users/ [user]/Library/Application Support/Enfocus/Switch Server/ScriptData/
com.tilia.griffin.app/log/rolling.log

«  On Windows:

C:\Users\ [user] \AppData\Roaming\Enfocus\Switch Server\ScriptData
\com.tilia.griffin.app\log\rolling.log

Most of the time, the log will point directly to the error, for example:

'The license on this machine has been activated on another machine.

valid license in order to continue using Griffin Auto on this machine.'

In any event, this log will be helpful in diagnosing the issue.
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